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BAB III 

METODOLOGI PENELITIAN 

 

A. Metode Penelitian 

Metode penelitian adalah suatu cara yang ditempuh untuk memperoleh 

data, menganalisis, dan menyimpulkan hasil penelitian. Penggunaan metode 

dalam pelaksanaan penelitian adalah hal yang sangat penting, sebab dalam 

menggunakan metode penelitian yang tepat, diharapkan dapat mencapai tujuan 

yang diinginkan. Disamping itu, penggunaan metode tergantung kepada 

permasalahan yang dibahas, dengan kata lain penggunaan metode dikatakan 

efektif apabila selama pelaksanaan terdapat adanya perubahan positif menuju 

tujuan yang diharapkan. Sedangkan suatu metode dikatakan efisien apabila 

penggunaan waktu, fasilitas, biaya, dan tenaga dapat dilaksanakan sehemat 

mungkin namun mencapai hasil maksimal. Metode dikatakan relevan apabila 

waktu penggunaan hasil pengolahan dengan tujuan yang hendak dicapai tidak 

terjadi penyimpangan. 

Sesuai dengan tujuan penelitian ini,yaitu pengaruh small side games dan 

kemampuan VO2 Max terhadap keterampilan bermain sepakbola, Maka metode 

penelitian yang digunakan adalah metode eksperimen. Sugiyono (2012, hlm.106) 

menyatakan bahwa, “Metode penelitian eksperimen dapat diartikan sebagai 

metode penelitian yang digunakan untuk mencari pengaruh perlakuan tertentu 

terhadap hal yang lain dalam kondisi yang terkendali. Sesuai dengan masalah 

yang dikaji oleh peneliti maka dari itu peneliti menggunakan metode penelitian 

eksperimen sebagai metodenya.” 

 

B. Desain Penelitian 

Penggunaan desain dalam setiap penelitian dimaksudkan untuk 

memudahkan dan menunjang peneletian supaya lebih terarah. Desain yang 

digunakan dalam peneletian ini adalah factorial design menurut Fraenkel dan 

Wallen (2009, hlm. 277) “Another value of a factorial design is that it allows a 

researcher to study the interaction of an independent variable with one or more 
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other variables.” Adapun rancangna penelitian desain faktorial 2 x 2 menurut 

Fraenkel & Wallen (2009, hlm. 277) adalah sebagai berikut:  

Tabel 3.1 

2x2 Factorial design 

Latihan 

 

VO2Max 

Small Side Games 

Model Random 

(A1) 

Model Blocked 

(A2) 

Tinggi B1 A1B1 A2B1 

Rendah B2 A1B2 A2B2 

 

Keterangan: 

A = Latihan   

A1 = Small Side Games Random 

A2 = Small Side Games Blocked 

B = VO2Max 

B1 = VO2Max Tinggi 

B2 = VO2Max Rendah 

A1B1 = Perlakuan atau treatment berupa latihan Small Side Games Random  

kelompok VO2 Max tinggi  

A2B1 = Perlakuan atau treatment berupa  Latihan Small Side Games Blocked  

Kelompok VO2 Max tinggi 

A1B2 = Perlakuan atau treatment berupa  latihan Small Side Games Random  

kelompok VO2 Max rendah 

A2B2 = Perlakuan atau treatment berupa latihan Small Side Games Blocked  

kelompok VO2 Max rendah 

 

C. Pelaksanaan Penelitian 

1. Waktu Penelitian 

Dalam hal ini menurut Bompa (1999, hlm. 46) terjadinya peningkatan 

dalam latihan biasanya 4 minggu (1 bulan). Hal yang perlu diperhatikan adalah 

terjadi peningkatan dalam latihan, kemudian Sidik (2010, hlm. 158) menyakatkan 

bahwa: “sebagai akibat dari rangsangan latihan organisme akan mengalami 
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kelelahan, tetapi kelelahan dalam keadaan normal akan hilang dengan sendirinya 

dalam jangka waktu 12 – 24 jam.” Kemudian hasil penelitian Arifin (2012, hlm. 

40) “dengan16 pertemuan hasil penelitiannya terdapat pengaruh yang signifikan 

terhadap kemampuan belajar keterampilan bola voli.”  

Dalam penelitian ini, hal yang pertama dilakukan adalah melakukan pre 

test yang tujuannya adalah untuk memberikan gambaran secara umum terkait 

informasi awal sampel, kemudian menerapkan pola latihan bentuk latihan small 

side games (teratment) sejumlah 14 pertemuan setelah itu dilakukan post test yang 

bertujuan untuk melihat hasil akhir apakah terdapat peningkatan atau perubahan 

dari masing-masing sampel. Jadi dapat disimpulkan waktu pelaksanaan penelitian 

dilakukan selama satu minggu tiga kali dengan sejumlah 16 kali pertemuan, 

adapun untuk penjadwalan latihan yaitu hari senin, selasa, dan rabu durasi 

pertemuan latihan adalah 80 menit, mulai dari jam 15.00 wib – 18.00 wib.  

Tabel. 3.2.  

Jadwal Penelitian 

No Deskripsi Hari/Tanggal Waktu Lokasi 

1 

Tes Awal 

(Pretes) 

Keterampila

n bermain  

sepakbola 

Jumat dan Sabtu / 1 dan 2 

Desember 2017 
16.00 wib – 18.00 wib 

Lapangan 

Sepakbola 

Bintang 

Subang 

2 

Treatment 

(latihan 

small side 

games 

random dan 

blocked) 

Senin/4 Desember 2017 16.00 wib – 18.00 wib 

Lapangan 

Sepakbola 

Bintang 

Subang 

Rabu/6 Desember 2017 16.00 wib – 18.00 wib 

Jum’at/8 Desember 2017 16.00 wib – 18.00 wib 

Senin/11 Desember 2017 16.00 wib – 18.00 wib 

Rabu/13 Desember 2017 16.00 wib – 18.00 wib 

Jum’at/15 Desember 2017 16.00 wib – 18.00 wib 

Senin/18 Desember 2017 16.00 wib – 18.00 wib 

Rabu/20 Desember 2017 16.00 wib – 18.00 wib 

Jum’at/22 Desember 2017 16.00 wib – 18.00 wib 

Senin/ Desember 2017 16.00 wib – 18.00 wib 

Rabu/27 Desember 2017 16.00 wib – 18.00 wib 

Jum’at/29 Desember 2017 16.00 wib – 18.00 wib 

Senin/1 Januari 2018 16.00 wib – 18.00 wib 

Rabu/3 Januari 2018 16.00 wib – 18.00 wib 

3 

Tes Akhir 

(Posttest) 

Keterampila

n bermain 

sepakbola 

Jum’at/5 Januari 2018 16.00 wib – 18.00 wib 

Lapangan 

Sepakbola 

Bintang 

Subang 
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2. Gambaran Umum Sesi Latihan  

Gambaran umum mengenai pelaksanaan penelitian ini adalah terdapat 

tiga tahapan latihan yaitu latihan pendahuluan, latihan inti dan latihan penutup. 

Adapun penjelasannya adalah sebagai berikut: 

a. Latihan pendahuluan 

Latihan pendahuluan bertujuan untuk melakukan pemanasan dengan 

instruksi langsung dari penulis, di dalam latihan pendahuluan berisikan tentang 

pemansan yang bertujuan untuk mempersiapkan kondisi tubuh untuk melakukan 

aktivitas yang akan dilakukannya, dalam hal ini sesuai dengna Giriwijoyo dan 

Sidik (2012, hlm. 156) yang menyatakan bahwa: “latihan pendahuluan yang 

dimaksudkan untuk mempersiapkan raga untuk menjalani latihan inti atau 

pertandingan.” 

b. Latihan inti 

Latihan inti bertujuan untuk aktivitas inti yang akan dilakukan oleh 

sampel  dengan instruksi dan bimbingan dari penulis, dalam hal ini adalah latihan 

teknik keterampilan bermain sepakbola dengan bentuk latihan small side games 

random dan small side games blocked. 

c. Latihan Penutup 

Latihan penutup disini bertujuan untuk menutup atau mengakhiri sesi 

latihan yang bertujuan untuk mendinginkan atau merelaksasikan anggota tubuh 

yang digunakan sebelumnya, dalam hal ini yang dikemukakan oleh Giriwijoyo 

dan Sidik (2012, hlm. 161) “ . . . gerakan-gerakan ringan yang juga menyerupai 

peregangan atau pelemasan.” 

Tabel.3.3. 

Rencana Program Sesi Latihan 

No 
Tahapan 

Latihan 
Aktivitas 

Bentuk Small 

sided game 

Blocked 

Bentuk 

Small sided 

game 

Random 

Deskriptif 
Duras

i 

1 

Latihan 

Pemanas

an 

Pemanasan 

statis, 

dinamis dan 

joging  

Pemanasan 

statis, 

dinamis dan 

joging  

Pemanasan 

statis, 

dinamis dan 

joging  

 

15 

menit 
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2 
Latihan 

Inti 

Pemain 

melakukan 

masing-

masing 

latihan 

small side 

games 

Small sided 

games 

 

1 vs 1 

Small sided 

games 

 

2 vs 2 

Pemain 

melakukan 

teknik 

dasar 

dengan 

ukuran 

lapangan 

10m x 7m 

15 

menit 

Istirahat 
 5 

menit 

Small sided 

games 

 

2 vs 2 

Small sided 

games 

 

3 vs 3 

Pemain 

melakukan 

teknik 

dasar 

dengan 

ukuran 

lapangan 

10m x 7m 

15 

menit 

Istirahat 
 5 

menit 

Small sided 

games 

 

3 vs 3 

Small sided 

games 

 

1 vs 1 

Pemain 

melakukan 

teknik 

dasar 

dengan 

ukuran 

lapangan 

20m x 

15m 

15 

menit 

Istirahat 
 5 

menit 

Small sided 

games 

 

4 vs 4 

Small sided 

games 

 

5 vs 5 

Pemain 

melakukan 

teknik 

dasar 

dengan 

ukuran 

lapangan 

20m x 

15m 

15 

menit 

Istirahat  
 5 

menit 

Small sided 

games 

 

5 vs 5 

Small sided 

games 

 

4 vs 4 

Pemain 

melakukan 

teknik 

dasar 

dengan 

ukuran 

15 

menit 
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lapangan 

20m x 

15m 

3 Latihan 

Penutup 

Pemain 

melakukan 

colling 

down dan 

evaluasi 

Statis , Pasif 

dan evaluasi 

Statis , Pasif 

dan evaluasi 

Statis , 

Pasif dan 

evaluasi 

15 

menit 

 

3. Tempat Latihan  

Penelitian ini dilakukan di lapangan bintang yang beralamat di Jl. Emo 

Kurniaatmaja, Pasirkareumbi, Kec. Subang, Kabupaten Subang, Jawa Barat 

41211 

 

D. Populasi dan Sampel Penelitian 

1) Populasi Penelitian 

Populasi adalah seluruh objek atau subjek yang akan diteliti, 

sebagaimana dijelaskan oleh Sugiyono (2012, hlm.119) bahwa “populasi adalah 

wilayah generalisasi yang terdiri atas objek/subjek yang mempunyai kualitas dan 

karakteristik tertentu yang ditetapkan oleh peneliti untuk dipelajari dan kemudian 

ditarik suatu kesimpulan.” Sesuai dengan pendapat tersebut peneliti 

menyimpulkan bahwa populasi bukan hanya manusia sebagai makhluk hidup 

melainkan dapat juga berupa benda-benda mati yang ada di alam dunia ini, dan 

populasi bukan hanya sekedar objek atau subjek saja, tetapi meliputi seluruh 

karakteristik sifat, perilaku, keadaan dan lain-lain yang dimiliki oleh objek atau 

subjek tersebut. Dalam penelitian ini populasi yang diteliti adalah UKM 

sepakbola Universitas Subang 

 

2) Sampel Penelitian 

Mengenai Sampel Sugiyono (2012, hlm. 117) menjelaskan bahwa 

“sampel adalah bagian dari jumlah dan karakteristik yang dimiliki oleh populasi 

tersebut”. Bila sebuah populasi tergolong kedalam kategori besar maka seorang 

peneliti secara kasar tidak akan memaksakan mempelajari seluruh populasi yang 

ada, karena dibenturkan oleh beberapa keterbatasan, misalnya keterbatasan dari 

materi, waktu serta sumber daya manusia. Maka peneliti dapat menggunakan 
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sampel yang diambil dari populasi itu dengan catatan sampel tersebut harus 

bersifat benar-benar mewakili dari populasi tersebut. 

Dikarenakan keterbatasan waktu yang kami persiapkan dalam penelitian 

ini serta jumlah sampel yang akan digunakan di dalam penelitian ini, maka peneiti 

dalam penelitian ini menggunakan teknik pengambilan sampel dalam penelitian 

ini menggunakan total sampling, menurut Sugiyono (2011,hlm.124) “sampling 

jenuh adalah teknik penentuan sampel bila semua anggota populasi digunakan 

sebagai sampel.” karena jumlah populasi yang cukup sedikit sehingga peneliti 

memilih menggunakan sampling jenuh, bersamaan dengan ini, Sugiyono 

menyatakan (2011, hlm. 125) menyatakan, bahwa: “hal ini sering dilakukan bila 

jumlah populasi relatif kecil, kurang dari 30 orang, atau penelitian yang ingin 

membuat generalisasi dengan kesalahan yang sangat kecil.”Dalam penelitian ini, 

Sampelnya adalah mahasiswa yang aktif mengikuti ukm sepakbola yang 

berjumlah 20 mahasiswa. 

Kemudian terkait dengan penelitian yang akan dilaksanakan, menurut 

Fraenkell dan Wallen (2012, hlm. 277) mengenai sampel dalam metode desain 

faktorial, menjelaskan bahwa:  

 

“factorial designs extend the number of relationships that may be 

examined in an experimental study. They are essentially modifications of 

either the posttest-only control group or pretest-posttest control group 

designs (with or without random assignment). 

 

Maka dengan demikian, dalam metode eksperimen desain faktorial dalam 

menentukan sampel, dapat ditentukan dengan atau tanpa random assignment. 

Kemudian setelah semua sampel telah melakukan tes VO2 Max, maka peneliti 

menempatkan seluruh sampel menjadi empat kelompok, dengan cara seperti 

dibawah ini: 

1. Peneliti merangking sampel yang telah mengikuti tes VO2 Max dari sampel ke 

1 sampai sampel ke 20 

2. Kemudian membagi sampel ke dalam dua kelompok yaitu kelompok A dari 

rangking 1 sampai dengan 10 dengan VO2 Max tinggi dan kelompok B dari 

rangking 11 sampai dengan 20 dengan VO2 Max rendah. 
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3. Kemudian masing-masing kelompok tersebut dibagi menjadi 2 kelompok 

kecil dengan menggunakan teknik matching paired dengan rumus ABBA dari 

mulai urutan sampel yang paling atas, sehingga  diperoleh 4 kelompok kecil 

yang masing-masing kelompok berjumlah 5 sampel. 

4. Kemudian setiap kelompok tersebut diacak menggunakan random assignment 

untuk menentukan banyak mana dan mendapatkan treatment apa. 

5. Kelompok sampel dengan VO2 Max tinggi  

Kel. A : 1, 4, 5, 8, 9. 

Kel. B  : 2, 3, 6, 7, 10. 

6. Kelompok sampel dengan VO2 Max rendah  

Kel A  : 11,14, 15,18, 19. 

Kel B  : 12,13, 16, 17, 20.  

Setelah dikelompokkan kemudian diberikan perlakuan. (A) latihan small 

side games model random  10 orang yang terdiri dari 5 orang yang memiliki VO2 

Max tinggi dan 5 orang yang memiliki VO2 Max rendah. dan perlakuan (B) small 

side games model blocked  10 orang yang terdiri dari 5 orang yang memiliki VO2 

Max tinggi dan 5 orang yang memiliki VO2 Max rendah.  Berikut ini masing-masing 

sampel dapat dilihat pada gambar 3.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar.3.1. 

Pembagian kelompok sampel 

1, 4, 5, 8, 9. 2, 3, 6, 7, 10. 

11,14, 15,18, 19. 12,13, 16, 17, 20.. 

A1B1 

Kelompok sampel small 

sided games random 

tingkat VO2 Max tinggi   

 

A1B2 

Kelompok sampel small 

sided games random 

tingkat VO2 Max rendah 

A2B1 

Kelompok sampel small 

sided games blocked 

tingkat  VO2 Max tinggi  

 

A2B2 

Kelompok sampel small 

sided games blocked 

tingkat VO2 Max rendah  
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E. Variabel Penelitian 

1. Variabel Bebas 

Menurut Sugiyono (2011, hlm. 61) “variabel bebas adalah variabel yang 

mempengaruhi atau yang menjadi sebab perubahannya atau timbulnya variabel 

terikat.” Kemudian menurut Sutisna (2014, hlm. 66) “variabel bebas sering juga 

disebut variabel stimulus.” Dalam penelitian ini, variabel bebasnya adalah Small 

side games model random dan Small side games model blocked 

 

2. Variabel Moderat/Atribut 

Menurut Sugiyono (2011, hlm. 62)  “variabel atribut adalah variabel 

yang mempengaruhi (memperkuat dan memperlemah) hubungan antara variabel 

bebas (independen) dengan variabel terikat (dependen).”adapun untuk variabel 

atribut dalam penelitian ini adalah VO2 Max. 

 

3. Variabel Terikat 

Menurut Sugiyono (2011, hlm. 61) “variabel terikat merupakan variabel 

yang dipengaruhi atau yang menjadi akibat karena adanya variabel bebas.” Lebih 

lanjut Sutisna (2014, hlm. 68) dalam penelitiannya mengungkapkan bahwa 

“disebut variabel terikat karena variabel ini dipengaruhi oleh variabel bebas 

(independen).” Dalam penelitian ini, variabel terikatnya adalah keterampilan 

bermain sepakbola. 

 

F. Validitas Penelitian 

1. Validitas Internal 

Validitas internal ini adalah tingkatan hasil penelitian dapat dipercaya 

kebenarannya atau  berkenaan dengan derajat akurasi antar desain penelitian dan 

hasil yang dicapai. Validitas internal merupakan hal yang esensial yang harus 

dipenuhi jika peneliti menginginkan hasil studinya bermakna. Terkait dengan 

penelitian ini, peneliti menggunakanan desain factorial. Adapun kelemahan dari 

penelitian menggunakan metode eksperimen dengan desain factorial menurut 

Frankel dan Wallen (2012, hlm. 276) adalah “. . .  location, data collector 

characteristic, data collector bias, attitude of subject, implementation.” Adapun 
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penjelasan terkait ancaman tersebut menurut Frankel dan Wallen (2012, hlm.169-

176 ), adalah sebagai berikut: 

 

1) Location  

The particular locations in which data are collected, or in which an 

intervention is carried out, may create alternative explanations for 

results.”  

2) Data collector characteristic 

The characteristics of the data gatherers—an inevitable part of most 

instrumentation—can also affect results. Gender, age, ethnicity, 

language patterns, or other characteristics of the individuals who collect 

the data in a study may affect the nature of the data they obtain 

3) Data collector bias 

There is also the possibility that the data collector(s) and/or scorer(s) 

may unconsciously distort the data in such a way as to make certain 

outcomes (such as support for the hypothesis) more likely. 

4) Attitude of subject 

How subjects view a study and participate in it can also threaten internal 

validity. 

5) Implementation 

The treatment or method in any experimental study must be administered 

by someone—the researcher, the teachers involved in the study, a 

counselor, or some other person. 

 

Untuk penelitian ini, lokasi yang dijadikan tempat penelitian tidak 

berpindah-pindah tempat, sehingga memudahkan peneliti dan sampel melakukan 

penelitian. Kemudian terkait karakteristik data yang di ambil dalam penelitian ini, 

dari mahasiswa yang mengikuti kegiatan ukm sepakbola yaitu berusia 19 - 21 

tahun, kemudian untuk meminimlakan data bias, peneliti dibantu beberapa rekan 

yang memang memiliki kemampuan yang membantu dalam melakukan penelitian 

ini, seperti contoh pelatih sepakbola, pemain sepakbola, terkait sikap dan 

pelaksanaan, peneliti memberikan sebuah penekanan terhadap sampel agar selalu 

fokus dalam penelitian ini. 

2. Validitas Eksternal 

Validitas eksternal adalah pengendalian terhadap beberapa faktor agar 

hasil dapat digeneralisasikan. Adapun kelemahan validitas eksternal dari 

penelitian yang menggunakan metode eksperimen dengan desain factorial 

menurut Frankel dan Wallen (2012, hlm. 276) “ . . . Subjects Characteristics, 
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Mortality, Instrumen decay, Testing, History, Maturation, Regression.” Adapun 

penjelasan terkait ancaman tersebut menurut Frankel dan Wallen (2012, hlm.169-

176 ), adalah sebagai berikut: 

 

1) Subjects Characteristics 

The selection of people for a study may result in the individuals (or 

groups) differing from one another in unintended ways that are related to 

the variables to be studied. This is sometimes referred to as selection 

bias, or a subject characteristics threat. 

2) Instrumen decay 

Instrumentation can create problems if the nature of the instrument 

(including thescoring procedure) is changed in some way or another 

3) Testing 

In intervention studies, where data are collected over a period of time, it 

is common to test subjects at the beginning of the intervention(s). By 

testing, we mean the use of any form of instrumentation, not just “tests.” 

4) History 

On occasion, one or more unanticipated, and unplanned for, events may 

occur during the course of a study that can affect the responses of 

subjects (Figure 9.6). Such an event is referred to in educational 

research as a history threat. 

5) Maturation 

Often, change during an intervention may be due to factors associated 

with the passing of time rather than to the intervention itself This is 

known as a maturation threat 

6) Regression 

A regression threat may be present whenever change is studied in a 

group that is extremely low or high in its preintervention performance. 

 

Instrumen yang digunakan pada penelitian pada saat tes awal dan tes 

akhir harus sama, kemudian pengambilan teknik sampel juga harus diperhatikan, 

dalam penelitian ini teknik pengambilan sampel menggunakan sampel jenuh, 

instrumen yang digunakan dalam penelitian ini sudah baku. Dalam masa 

perlakuan penerapan program penelitian, sampel berlatih sesuai dengan jadwal 

yang telah ditentukan oleh sekolah. Perubahan yang sering terjadi, karena sampel 

cedera pada saat melakukan latihan atau cedera di luar program penelitian. 

Ancaman regresi disini penerapan dalam penelitian ini, mengintervensi kepada 

sampel ketika penelitian dilakukan harus dalam motivasi yang tinggi sehingga 

mendapatkan hasil yang maksimal. 
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G. Batasan Penelitian 

Batasan penelitian ini bertujuan untuk membatasi pembahasan pada 

pokok permasalahan penelitian saja. Ruang lingkup menentukan konsep utama 

dari permasalahan sehingga masalah-masalah dalam penelitian dapat dimengerti 

dengan mudah dan baik. Dalam batasan penelitian ini terkait sampel penelitian 

adalah jumlah total sampel adalah 20, sehingga dalam penelitian ini menggunakan 

total sampling atau semua populasi dijadikan sampel, selanjutnya tingkatan 

tingkatan kemampuan VO2 Max dikategorikan kedalam dua tingkatan, yaitu 

kategori tinggi dan rendah sehingga dalam penelitian ini tidak menggunakan 

kategori sedang, dapat juga untuk penelitian selanjutnya menggunakan kategori 

tersebut.  

Dengan demikian, sehubungan  dengan jumlah populasi yang mengikuti 

UKM Sepakbola berjumlah 20 Universitas tersebut, sehingga peneliti 

menggunakan seluruh populasi menjadi sampel pada penelitian ini. Kemudian 

yang seharusnya pre test dilakukan untuk mengendalikan variabel atribut karena 

dengan situasi demikian maka dilakukan pre test dan post test. 

 

H. Instrumen Penelitian 

Dalam mengumpulkan data dari suatu sampel penelitian diperlukan alat 

yang disebut instrumen dan teknik pengumpulan data. Setiap teknik atau metode 

pengumpulan data menggunakan instrumen pengumpulan data yang berbeda-

beda. Dalam suatu penelitian, data diperlukan untuk menjawab masalah penelitian 

atau menguji hipotesis yang sudah dirumuskan. Sebagaimana dijelaskan oleh 

Arikunto (2006,hlm.160) mengemukakan bahwa instrumen penelitian adalah alat 

atau fasilitas yang digunakan oleh peneliti dalam mengumpulkan data agar 

pekerjaannya lebih mudah dan hasilnya lebih baik, dalam arti lebih cermat, 

lengkap, dan sistematis sehingga lebih mudah diolah. 

Dalam konteks penelitian, instumen diartikan sebagai alat untuk 

mengumpulkan data mengenai variabel-variabel penelitian untuk kebutuhan 

penelitian. Pada dasarnya, instrumen pengumpulan data terbagi dua macam, yaitu 

tes dan non tes. Kelompok tes, misalnya tes bakat, tes prestasi belajar, tes 

integrasi, sedangkan non tes, misalnya pedoman wawancara, kuisioner atau 
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angket, pedoman observasi, daftar cocok (cheklist), skala sikap, skala penilaian, 

dan sebagainya. 

Menurut Arikunto (2000,hlm.150) tes adalah serentetan pertanyaan atau 

latihan serta alat lain yang digunakan untuk mengukur keterampilan, pengetahuan 

intelegensi, kemampuan atau bakat yang dimiliki oleh individu atau kelompok”. 

Oleh sebab itu, validitas dan reliabilitas suatu alat ukur merupakan syarat mutlak  

dalam menentukan penggunaan alat ukur untuk pengukuran dan pengetesan dalam 

penelitian.  

 

1. Instrumen VO2 Max 

Instrumen untuk mengukur VO2 Max menggunakan instrumen bleep test, 

karena instrumen tersebut sudah digunakan diberbagai organisasi untuk mengetes 

kemampuan VO2 Max. Diantaranya yang menggunakan menurut sumber 

wikipedia adalah Western Australian Rugby Union References, Wasit Rugby 

Football, Tentara Inggris, Polisi Skotlandia, Departemen Pendidikan New York 

City. Dari beberapa sumber mengenai instrumen bleep test yang telah diterapkan 

maka dari itu, sebagai peneliti akan menerapkan instrumen tersebut di cabang 

olahraga sepakbola. maka denga itu, bleep test akan menjadi ukuran kebugaran 

tubuh. Bleep test biasanya digunakan untuk mengukur VO2 max dan tingkat 

kebugaran seseorang.  

Tes ini meliputi berlari terus menerus di antara dua garis yang berjarak 

20 meter selama terdengar suara beep yang sudah direkam sebelumnya. Menurut 

Yaya, hasil tes pertama ini tidak bisa menjadi justifikasi untuk menilai baik atau 

buruknya kualitas seorang pemain. "Target dari latihan dan tes ini adalah melihat 

bagaimana kemampuan pemain pada kondisi aerobik. Lihat perkembangan 

pemain yang dalam kondisi cedera. Akan ada satu kali lagi tes seperti ini, nanti di 

awal Maret 2017," ujar Yaya. Maka atas dasar itu, menggunakan bleep test. 

Adapun dibawah ini merupakan berbagai komponen pununjang instrumen bleep 

test adalah sebagai berikut:   
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a. Tujuan 

Instrumen yang digunakan pada penelitian ini menggunakan tes lari multi 

tahap atau biasa disebut juga dengan bleep test bertujuan untuk mengukur 

kapasitas VO2max.  

b. Deskripsi 

Tes ini meliputi berlari terus menerus diantara dua garis yang berjarak 20 

m selama terdengar suara bleep yang sudah direkam sebelumnya. Itulah sebabnya 

test ini sering juga disebut ‘beep test'. Atlet berdiri di belakang garis pertama 

menghadap ke garis kedua, dan mulai berlari sesuai aba-aba dari CD atau tape. 

Kecepatan pada start sangat lambat. Atlet terus berlari di antara kedua garis, 

berbalik arah bila terdengar suara beep yang sudah terekam. Sesudah sekitar satu 

menit, kecepatan suara beep akan bertambah, dan tenggang suara beep menjadi 

lebih cepat. 

c. Prosedur Pelaksanaan Bleep Test 

1) Bleep Test dilakukan dengan lari menempuh jarak 20 meter bolak-balik, yang 

dimulai dengan lari pelan-pelan secara bertahap yang semakin lama semakin 

cepat hingga atlet tidak mampu mengikuti irama waktu lari, berarti 

kemampuan maksimalnya pada level bolak-balik tersebut. 

2) Waktu setiap level 1 menit. 

3) Pada level 1 jarak 20 meter ditempuh dalam waktu 8,6 detik dalam 7 kali 

bolakbalik. 

4) Pada level 2 dan 3 jarak 20 meter ditempuh dalam waktu 7,5 detik dalam 8 kali 

bolak-balik.Pada level 4 dan 5 jarak 20 meter ditempuh dalam waktu 6,7 detik 

dalam 9 kali bolak-balik, dan seterusnya. 

5) Setiap jarak 20 meter telah ditempuh, dan pada setiap akhir level, akan 

terdengar tanda bunyi 1 kali. 

6) Start dilakukan dengan berdiri, dan kedua kaki di belakang garis start. Dengan 

aba-aba “siap ya”, atlet lari sesuai dengan irama menuju garis batas hingga satu 

kaki melewati garis batas. 

7) Bila tanda bunyi belum terdengar, atlet telah melampuai garis batas, tetapi 

untuk lari balik harus menunggu tanda bunyi. Sebaliknya, bila telah ada tanda 
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bunyi atlet belum sampai pada garis batas, atlet harus mempercepat lari sampai 

melewati garis batas dan segera kembali lari ke arah sebaliknya. 

8) Bila dua kali berurutan atlet tidak mampu mengikuti irama waktu lari berarti 

kemampuan maksimalnya hanya pada level dan balikan tersebut. 

9) Setelah atlet tidak mampu mengikuti irama waktu lari, atlet tidak boleh terus 

berhenti, tetapi tetap meneruskan lari pelan-pelan selama 3-5 menit untuk 

cooling down. 

d. Scoring  

Score atlet ditunjukkan dengan level dan jumlah lari bolak-balik yang 

dicapai sebelum mereka gagal menyesuaikan dengan rekaman bleep. Score ini 

bisa dikonversikan ke dalam ‘VO2max equivalent score' dengan menggunakan 

tabel terlampir. 

e. Perlengkapan yang diperlukan: 

Tempat datar yang rata dan tidak licin, ‘marking cones' atau kapur, pita 

meteran (20m), ‘shuttle run CD, CD player dan lembar catatan 

     

 

 

 

 

Gambar.3.2. 

Jarak Bleep test 

Sumber: Hazard (2012, hlm. 1) 

 

2. Instrumen Keterampilan Bermain Sepakbola 

Alat ukur yang penulis gunakan dalam penelitian ini adalah tes 

keterampilan bermain sepakbola Griffin, Mitchell Olsin.(1997,hlm.219). 

Instrumen yang digunakan peneliti adalah melalui tes keterampilan bermain 

sepakbola menggunakan instrumen yang telah ada yang dikutip Griffin,Mitchell 

Olsin.(1997) mengenai GPAI (GAME PERFORMANCE ASSESSMENT 

INSTRUMENT).  Tes terdiri dari dua tes yaitu pre test dan post tes. Pre test 

dilakuan sebelum kelas diberi perlakuan dan post tes dilakukan setelah diberi 

perlakuan. 
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Pada penilaian penelitian bermain siswa pada dasarnya membutuhkan 

kecermatan observasi pada saat permainan berlangsung. Griffin dan, mitchell dan 

oslin (1997) telah menciptakan instrument penilaian yang bernama Game 

Performance Assessment instrument (GPAI).untuk selanjutnya GPAI akan 

diterjemahkan kedalam bahasa Indonesia yaitu instrument penilaian keterampilan 

bermain disingkat IPPB.. Tujuannya untuk membantu para guru dan pelatih 

mengobservasi dan mendata perilaku penampilan pemain sewaktu permainan 

berlangsung. Ada tujuh komponen yang diamati untuk mendapatkan gamabaran 

tentang tingkat penampilan bermain siswa. Pengamatan untuk cabang olahraga 

permainan bisa memanfaatkan ketujuh komponen tersebut : 

a. Kembali ke Pangkalan (home base) maksudnya adalah seorang pemain yang 

kembali ke posisi semula setelah dia melakukan suatu gerakan keterampilan 

tertentu. 

b. Menyesuaikan diri (adjust) maksudnya adalah pergerakan seorang pemain saat 

menyerang atau bertahan yang disesuaikan dengan tuntunan situasi 

permainan. 

c. Membuat keputusan (decision making) komponen ini dilakukan setiap 

pemain, setiap saat di dalam situasi permainan yang bagaimanapun. 

d. Melaksanakan keterampilan tertentu (skill executive) setelah membuat 

keputusan, barulah seorang pemain melaksanakan macam keterampilan yang 

dipilihnya. 

e. Memberi dukungan (support) 

f. Melapis teman (cover) gerakan ini dilakukan untuk melapis pertahanan 

dibelakang teman satu tim yang sedang berusaha menghalangi laju serangan 

lawan atau yang sedang bergerak kearah lawan yang menguasai bola. 

g. Menjaga atau mengikuti gerak lawan (guard or mark) maksudnya adalah 

menahan laju gerakan lawan, baik yang sedang atau yang tidak mengusai bola. 

Dari ketujuh komponen penilaian bermain ini, menurut Metzler (2000, 

hlm. 363) “The GPAI  focuses on three aspects of performance on each 

component: decision made (appropriate or inappropriate), skill execution 

(efficient or ineffecient), and support (appropriate or inappropriate).” Bersamaan 
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dengan hal tersebut, maka komponen dalam penelitian ini yang akan di teliti 

adalah sebagai berikut: 

 

Tabel. 3.4. 

Komponen Penilaian GPAI Sepakbola 

Komponen Kriteria Tepat Tidak tepat 

Decision 

Making 

(Mengambi

l 

Keputusan) 

1. Pemain mencoba 

melakukan shooting 

ke arah gawang 

2. Pemain mencoba 

melakukan passing 

untuk membuka 

ruang 

3. Pemain mencoba 

melakukan dribble 

bola ke pertahanan 

lawan 

4. Pemain mencoba 

melakukan stopping 

bola  

5. Pemain mencoba 

melakukan heading 

bola  

1. Pemain 

melakukan 

shooting ke arah 

gawang 

2. Pemain 

melakukan 

passing untuk 

membuka ruang 

3. Pemain 

melakukan 

dribble bola ke 

pertahanan lawan 

4. Pemain dapat 

melakukan 

stopping dengan 

baik 

5. Pemain dapat 

melakukan 

heading dengan 

baik 

1. Pemain tidak 

melakukan 

shooting ke arah 

gawang 

2.  Pemain tidak 

melakukan 

passing untuk 

membuka ruang 

3. Pemain tidak 

melakukan 

dribble bola ke 

pertahanan 

lawan 

4. Pemain tidak 

dapat 

melakukan 

stopping dengan 

baik 

5. Pemain tidak 

dapat 

melakukan 

heading dengan 

baik 

Skill 

Execution 

(Eksekusi 

Keterampil

1. Pemain melakukan 

passing sesuai 

target 

2. Pemain melakukan 

1. Pemain 

melakukan 

passing sesuai 

target 

1. Pemain 

melakukan 

passing tidak 

sesuai target 
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an) shooting ke gawang 

3. Pemain mampu 

melewati lawan 

dengan mendribble 

bola 

4. Pemain mampu 

melakukan stopping 

bola  

5. Pemain mampu 

melakukan heading 

bola 

2. Pemain 

melakukan 

shooting ke 

gawang 

3. Pemain mampu 

melewati lawan 

dengan 

mendribble bola 

4. Pemain mampu 

melakukan 

stopping bola 

dari rekan satu 

tim 

5. Pemain mampu 

melakukan 

heading bola 

sesuai dengan 

target 

2. Pemain 

melakukan 

shooting tidak 

ke gawang 

3. Pemain tidak 

mampu 

melewati lawan 

dengan 

mendribble bola 

4. Pemain tidak 

mampu 

melakukan 

stopping bola 

dari rekan satu 

tim 

5. Pemain tidak 

mampu 

melakukan 

heading bola 

sesuai dengan 

target 

Support 

(Memberi 

dukungan) 

Pemain memberi 

dukungan terhadap 

pemain yang lain 

dengan membuka 

ruang untuk menerima 

bola dan  membantu 

serangan. 

Pemain memberi 

dukungan terhadap 

pemain yang lain 

dengan membuka 

ruang untuk 

menerima bola dan  

membantu 

serangan. 

Pemain tidak 

memberi dukungan 

terhadap pemain 

yang lain dengan 

membuka ruang 

untuk menerima 

bola dan  

membantu 

serangan. 

 



   54 

 

Raden Dadan Pra Rudiana, 2018 
PENGARUH LATIHAN SMALL SIDE GAMES  DAN VO2 MAX TERHADAP KETERAMPILAN BERMAIN 
SEPAKBOLA  
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

Tabel 3.4. merupakan gambaran komponen yang akan menjadi indikator 

penilaian dari tes GPAI. Adapun form penilaian dan penghitungan instrumen 

GPAI adalah bisa dilihat di tabel 3.5. dibawah ini: 

 

 

Tabel. 3.5. 

Format Penilaian Tes Game Performance Assesment Instrument Sepakbola 

No Nama 

Decision Making 

(A) 

Skill Execution 

(B) 

Support 

(C) 

T TT E TE T TT 

1        

2        

3        

 

Kemudian untuk prosedur penilaian dari instrumen GPAI ini adalah 

menggunakan sistem perhitungan. Sesuai dengan penelitian ini yaitu akan 

mengukur keterampilan teknik bermain sepakbola yang notabenya memiliki 

karakteristik yang mampu terlihat melakukan beberapa keterampilan didalamnya. 

Bersamaan dengan itu, Metzler mengemukakan (2005, hlm. 50) “the tally system 

can be used with striking and fielding games”. Lebih lanjut karena menurut 

Metzler (2005, hlm. 50) “the tally system also provides a more precise 

performance measure.” Pengamatan GPAI bisa dilakukan oleh seorang peneliti, 

guru atau bahkan oleh rekan sepermainan (peer observation). Terkait mengenai 

pengamatan untuk penegtesan GPAI peneliti menggunakan 4 pengamat yang ahli 

di dalam sepakbola, dalam penelitian ini menggunakan expert dosen mata kuliah 

cabang olahraga sepakbola termasuk didalamnya saya sendiri. Kemudian untuk 

lamanya waktu tes GPAI ini menurut Metzler (2005, hlm. 424) waktu untuk tes 

instrumen GPAI ini adalah “ . . . observations during a 10-minute.” Untuk rumus 

penghitungan instrumen GPAI ini adalah : 

Decision making (A)  = T/TT = Skor 

Skill Execution (B)  = E/TE = Skor 

Support (C)   = T/TT = Skor 

GPAI    = (Skor A + B + C )/ 3 = Skor GPAI 
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I. Prosedur Penelitian 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar.3.3. 

Prosedur Penelitian 

 

J. Analisis Data 

Didalam penelitian ini menggunakan manusia sebagai subjek penelitian 

atau disebut dengan partisipan, patisipan dalam penelitian ini adalah mahasiswa 

Universitas Subang yang mengikuti UKM sepakbola yang akan di analisis dalam 

penelitian ini adalah hasil dari penggunaan instrumen penelitian yang telah 

dipaparkan di atas. Berikut teknik yang digunakan dalam penganalisisan data: 

 

 

 

Sampel 

Tes Awal Eksperimen 

 

Eksperimen 

 

Latihan Small Sided 

Games Random 
Latihan Small Sided 

Games Blocked 

 
Tes akhir 

Pengumpulan data 

Pengumpulan 

& Analisi Data 

kesimpulan 

Populasi 
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1. Rata-rata dan Simpangan Baku 

Untuk perhitungan rata-rata dan simpangan baku dengan menggunakan 

aplikasi Statistical Package for the Social Sciences (SPSS) versi 16. Tahapan 

penghitungan yang akan dilakukan dengan langkah-langkah sebagai berikut: klik 

Analyze > Descriptive Statistics > Descriptives > Masukan semua variabel ke 

kotak Variable(s) > Options > ceklis Mean dan Std. Deviation > Continue > OK. 

 

2. Uji Normalitas 

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui 

apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

kolmogorov-smirnov dengan bantuan Statistical Package for the Social Sciences 

(SPSS) versi 16. Tahapan penghitungan yang akan dilakukan dengan langkah-

langkah sebagai berikut: klik Analyze > Nonparametric Tests > 1-Sample K-S > 

Masukan semua variabel ke kotak Test Variable List > OK. Format pengujiannya 

dengan membandingkan nilai probabilitas (p) atau signifikansi (Sig.) dengan 

derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai berikut: 

a. Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal. 

b. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak normal. 

 

3. Uji Homogenitas 

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau 

sampel yang diambil berasal dari varian yang homogen atau tidak. Uji 

homogenitas dilakukan sebagai prasyarat dalam uji anova. Uji homogenitas 

menggunakan Lavene Statistic dengan bantuan Statistical Package for the Social 

Sciences (SPSS) versi 16. Tahapan penghitungan yang akan dilakukan dengan 

langkah-langkah sebagai berikut: klik Analyze > Compare Means > One-Way 

ANOVA > Masukan variabel ke kotak Dependent List > Masukan faktor ke kotak 

Factor > Options > Homogenity of variance test > Continue > OK.  
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Format pengujiannya dengan membandingkan nilai probabilitas (p) atau 

signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya 

sebagai berikut: 

a. Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan homogen. 

b. Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak homogen. 

 

4. Pengujian Hipotesis 

Analisis varian desain faktorial menggunakan Statistical Package for the 

Social Sciences (SPSS) versi 16. Kemudian untuk pengujian hipotesis dalam 

penelitian ini menggunakan teknik analisis varian univariate (Two way Anova) 

faktorial dua arah pada taraf signifikansi α= 0,05 adapun tahapan penghitungan 

yang akan dilakukan dengan langkah-langkah sebagai berikut: 

Setelah langkah-langkah di atas lalu klik Analyze > General Linear Model 

> Univariate > Masukan data keterampilan bermain sepakbola ke kotak 

Dependent Variable, masukan latihan small sided games dan VO2 Max ke kotak 

Fixed factor(s) > klik Plot masukkan motor ability ke kotak Horizontal Axis dan 

metode latihan ke kotak Separate Lines > add > continue > klik Post Hoc, 

masukkan metode latihan ke kotak Post Hoc Test for > Tukey > continue > klik 

OK.  

 

 

 

 

 


